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Demonstration of the SIGIQPro Bluetooth signal generation and
SSA5000A Bluetooth analysis function

Introduction

As a wireless communication technology, Bluetooth technology is widely used in various devices
and application scenarios. The article aims at RF verification of Bluetooth transmitter. Through
fast one-click RF measurement, SSA5000A spectrum analyzer is transformed into a standard-
based Bluetooth RF transmission tester to help you design, evaluate and manufacture Bluetooth
devices. The measurement application conforms to the standard of Bluetooth core specification,
and can safely verify your Bluetooth design, covering Bluetooth BR, EDR and LE. The article will
demonstrate how to use the Bluetooth analysis function of SSA5000A to carry out Bluetooth
analysis and measurement quickly and effectively.

1.1 Bluetooth Analysis Function

Bluetooth SIG specifies the RF test items of Bluetooth® Classic and Bluetooth® Low Energy
Bluetooth measurement specifications. Tables 2 and 3 list the corresponding test items
supported by SSA5000A and suitable for transmitter testing. The SIGLENT Bluetooth
measurement application refers to the following Bluetooth RF test specifications:

Table 1 Supported standard versions

Type Bluetooth device

Bluetooth radio frequency system specification 1.2/2.0/2.0+EDR/2.1/2. 1+EDR
revision 2.1.E.0

Standard - basic rate

version - enhanced data rate

Bluetooth Low Energy RF PHY test specification (LE RF-PHY.TS/4.0/4.2)
Bluetooth RF PHY test specification (Bluetooth 5, 5.1 and 5.3)

Power Class 1, class 2 and class 3
Bluetooth basic rate and EDR system:
2.400 to 2.4835 GHz (f = 2402 +k MHz, k = 0, -, 78)
Frequency
Bluetooth low energy system:
2.400 to 2.4835 GHz (f = 2402 +kx2 MHz, k = 0, -, 39)
Table 2 Supported Classic test items
Transmitter test | TP/TRM/CA/BV-xx—C
Basic Rate (BR)
Output power 01
Modulation characteristic 07
Initial carrier frequency 08
tolerance
Carrier frequency drift 09
Enhanced Data Rate (EDR)
EDR relative transmit power 10
EDR carrier frequency stability 1
and modulation accuracy
EDR differential phase encoding 12

Table 3 Supported LE test items

Low Energy (LE)

Transmitter test

LE 1M LE 2M LE 1M LE 2M Coded, S=8
1 Mb/s 2 Mb/s 1 Mb/s, SMI | 2 Mb/s, SMI | I Mb/s, SMI
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Output power 01
Modulation characteristics 05 10 09 11 13
Carrier frequency offset and 06 12 1

drift

1.2 Configuration information

You need to install the appropriate firmware version and options on the required instruments.

Table 4 Configuration information

Type Model Configuration information

Signal Generation Software SiglQPro Optional: SigiQPro-BT

Vector Signal Generator SSG5000X-V Firmware: V2.1.2.4.1and above
Optional: SiglQPro-BT

Arbitrary Waveform Generator | SDG7000A Firmware: V1.1.1.32 and above
Optional: SiglQPro-BT
Optional: SSA5000A-BT

1.3 Measurement Parameters

SSAS5000A Bluetooth analysis provides one-button measurement.

Table 5 Measurement Parameters

Bluetooth Analysis

Basic Rate (BR)

Enhanced Data Rate (EDR)

Low Energy (LE)

Output power

¢ Peak power

€ Average power

Modulation characteristics

¢ AF1 Avg/Max

€ AF2 Avg/Max

¢ AF1/AF2 Ratio

Initial carrier frequency
tolerance (ICFT)

Frequency offset

Carrier frequency drift

€ Frequency drift

¢ Max drift rate

€ Init freq drift

Relative transmit power
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*

GFSK average power

*

DPSK average power

*

Rel average power

Frequency stability and modulation accuracy

Freq offset w;

Freq offset w,

wotw;

RMS DEVM

*
*
*
*
*

Peak DEVM

Differential phase decoding

*

BER

*

Bit errors

*

99% DEVM

Guard Interval ®

1.4 Connection Settings

Connect a PC with SiglQPro software to SSG5000X-V / SDG7000A through GPIB / LAN / USB.
Complete the connection according to the setup instructions of SiglQPro, and then perform the
following steps to interconnect SSG5000X-V / SDG7000A and SSA5000A:

1) Connect SSG5000X-V/ SDG7000A RF output port to SSA5000A RF input port.

2) It is suggested to connect the 10 MHz IN output of SSG5000X-V / SDG7000A to the Ext
Refl port (back panel) of SSA5000A to improve the frequency accuracy.
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Figure 1-1 Connection settings
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1.5 Test Result

SSAS5000A calculates the measurement results according to the Bluetooth® RF test specification,
carries out Bluetooth BR/ EDR/LE one-button measurement and displays a single view with four
traces. The one-button measurement function can conveniently and quickly complete the test
purposes listed in Table 2 and 3 at one time, and provide an overview of multiple emission tests.
Users can switch from the four-trace overview to a single power, modulation and spectrum
measurement display to view the results in more detail. All signal parameters can be modified
independently, such as RF channel, packet type, mode type, etc. SSA5000A is helpful for users
to troubleshoot flexibly in the laboratory and optimize RF design easily and quickly.

SIGLENT 1) P & @& OB E

Blue Tooth1 Input Z: 500 Aften: 20 dB Center Freq: 2.402 GHz Sweep: Continue e
eEE ¥ FreqRefIn(S) Preamp: Off  Trig: Free Freg/Channel

» Trc 1: RF Envelope Channel

0

Center Freq

2402 GHzZ

CF Step
100 MHz

500 k
Stop 6 ms. Start0s Stop 1.624 ms

Packet Type: ACL_DH3 Payload: 0x55
Payload Length:  1456bits

Statistic Current MAX MIN

Pavg (dBm) -3.7879 -3.7799 -3.7936

Ppeak (dBm) -36923 -36758 -37019

AF1 Avg (Hz)

Af2 Avg (Hz) 13837k 13863 k 13812k

Af1 Max (Hz)

Af2 Max (Hz) 15864 k 16193k 16546 k

Af2> 115KHz () 100.00% 100.00% 100.00%

ATAR ()

Freq Drift (Hz) -1.2542 3.3902 -6.2948

Max Drift Rate () 442 89/50us 643 69/50us 368.35/50us
100 ICFT (Hz) -211.88 47117 -807.42

Center 2.402 GHz Span 4 MHz

Figure 1-2 Test result
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Using the SSA5000A noise figure measurement option

1 Introduction

The article demonstrates how to use the noise figure analysis function of SIGLENT SSA5000A
spectrum analyzer to make high quality noise figure measurements quickly and efficiently.

1.1 Noise Figure Fundamentals

1.1.1 Definition of Noise Figure

Noise is the interference generated inside components or systems, which leads to the
deterioration of circuit performance; There are three main parameters for noise quantization:
noise figure (NF), noise factor (F) and equivalent noise temperature (Te).

The noise factor (F) is defined as the ratio of the signal-to-noise power ratio at the input to the
signal-to-noise power ratio at the output.

Noise Factor: F = (Sin/Nin)/(Sout/Nout)

Where Sin = input signal power; Sout = output signal power; Nin = input noise power; Nout =
output noise power.

To express the noise factor in decibels (dB) is the noise figure (NF): NF (dB) = 10*log (F).

Most LNAs are described by noise figure, but Te is commonly used to characterize the noise of
an LNA when the noise factor is less than 1 dB: Te = 290*(F-1). The equation expresses the
relationship between noise figure and temperature: NF (dB) = 10*lg (1+ Te /290)

1.1.2Noise Figure Measurement Method

There are two main methods to measure noise figure: Y factor method and cold source method.
In this paper, we discuss the Y factor method.

The noise source is an essential equipment for the Y-factor method of measurement. The noise
source is a noise generator that can generate two different noise powers. Usually, it needs a DC
pulse power supply drive voltage. When the DC drive voltage is supplied, it is equivalent to the
noise source being on, which is called hot state. At this time, a large noise power is output. When
the power supply is turned off, it is equivalent to the noise source off, which is called cold state.
At this time, the noise power at room temperature is output. For a given noise source, the value
of ENR will change with frequency. According to the different internal attenuators, the nominal
value of ENR of typical noise sources ranges from 6 dB to 15 dB. Using the noise source, two
noise power measurement results can be obtained at the output port of the device under test.
The ratio of these two measurement results (called Y factor) can be used to calculate the noise
figure: NF=ENR-10Ig(Y-1), and ENR is generally given by the specifications of the noise source.
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1.2 Amplifier Measurement

In this section, a low noise amplifier with a frequency range of DC-10 GHz is used as an example
to demonstrate how to use the noise figure analysis function of SSA5000A to measure the noise
figure quickly and effectively.

Table 1-1 DUT Specifications

Frequency Range Gain Noise Figure

DC-10 GHz 26 dB 6 dB

1.2.1Calibration Step

In order to accurately measure the noise figure, before measuring the DUT, the measurement
system must be calibrated to identify and correct the inherent noise figure of the system, and the
measured instrument noise figure is removed from the total noise figure measurement value, so
that only the noise figure and gain of the DUT are displayed.
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Figure 1-2 Connection setting of noise figure measurement calibration

Operating procedure:

1.

After 30 minutes of warm-up, click Spectrum Analyzer in the upper left corner to enter the
window management page, and click Noise Figure (NF) > Noise Figure to add noise figure
analysis window. At this time, the SSA5000A works in the noise figure measurement mode.

Connect the noise source: Connect the noise source and the spectrum analyzer according
to the calibration settings in Figure 1-2. The analyzer controls the noise source through USB
connection and directly connects the output of the noise source to the RF signal input end
of the analyzer.

Setting amplitude: Select AMPTD|. When entering the noise figure mode, the internal
preamplifier will be turned on automatically, and the input attenuation value will be fixed at
0 in the automatic mode.

Setting frequency: Select [FREQ), set the start frequency to 10 MHz, the stop frequency to
10 GHz and the number of scanning points to 11.

Setting ENR: Select > ENR > Edit ENR and fill it in the ENR table, which is a
series of frequencies and ENR values corresponding to frequencies.

Save the ENR table: Select > ENR > Save and save the filled ENR value and
display - to verify the data has been transmitted correctly.
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SIGLENT

Continuous FREQ = RF

Meas Setup

Edit ENR

Freq ENR Value
10 MHz 551dB
100 MHz 555 dB
1 GHz 5.48 dB
2 GHz 55d8
Clear List 3 GHz 5.34 dB

4 GHz 5.24 dB

Point Freq 5 GHz 513dB

10 MHz 6 GHz 5.08 B

7 GHz 5.04 dB
ENR Value

551 dB 8 GHz 5.01dB

[Start 10 MHz Center 5

Span Sweep 21

Figure 1-3 ENR table

Set average: Select > Setting, the average number of times is 10 and switch
to on.

Perform calibration: Select Meas Setup [> Cail > Calibrate now > Enter.

SIGLENT

gure Ref 0.1dB

Figure 1-4 Noise figure measurement calibration

View the results in the table: Select[Trace|> Format > Layout > Table. When the calibration
is completed and the device under test is not inserted, the gain and noise figure are close to
0 dB, which indicates that the analyzer has removed the noise components from the
measurement system, and the results can be better viewed by using the table layout mode.
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SIGLENT 2
rce Drive  Atten: 0 dB [ Swep! Continuous FREQ = RF
Prez 5 Trace
reamp: On
DUT:Amplifier
Noise Figure Layout

0.09 dB

Table
1.009 GHz 0.41dB

2.008 GHz 0.09 4B L

3.007 GHz 0.31dB Aut Manual

4.006 GHz 0.35dB P hoticold Unit
5.005 GHz 0.29 dB
dB
6.004 GHz 1.03 dB
7.003 GHz 0.57 dB
8.002 GHz 0.7d8
9.001 GHz 0.63 dB

10 GHz 0.87 dB

Figure 1-5 Noise figure measurement calibration

1.2.2Measurement Step

After the calibration is completed, maintain the control of the analyzer on the noise source,
connect the output of the noise source to the input of the DUT, and connect the output of the
DUT to the RF signal input port of the analyzer.
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Figure 1-6 Connection settings for noise figure measurement
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After connecting the DUT and the noise source, the measurement results appear on the display
screen of the analyzer. The results show that the noise figure of DUT is 6.12 dB and the gain is
26.69 dB. Therefore, the device under test meets the manufacturer's specifications in the target
frequency range.

SIGLENT K )

Noise Source Drive wepl Sweep: Continuous FREQ =RF

Preamp: On

Ref 15612dB Scale/Div 3 dB

Start Freq

10 MHz

Stop Freq

10 GHz

Stop 10 GHz

Sweep 50 ms (11pts)

Figure 1-7 Noise figure measurement result
1.2.3Gain Measurement Method

We use the gain method to make a simple check on the measurement results. The accuracy of
this method is lower than that of the Y-factor method which needs to be calibrated by the noise
source, and it is equivalent to the amplitude accuracy of the analyzer.

DANL reflects the minimum level that the analyzer can measure, and also reflects the level of
internal noise of the analyzer. Connect a 50Q matching load to the input of the analyzer or directly
suspend the input interface, and the measured DANL is -161.92 dBm/Hz. Then, the output of the
amplifier is connected to the input of the analyzer, and the input of the amplifier is connected to
a 50Q matching load or directly suspended. The noise power spectral density measured without
power supply is -161.97 dBm/Hz, and the noise power spectral density measured with power
supply is -142.05 dBm/Hz.

Operating procedure:

1. Select[FREQ, set the center frequency to 5 GHz and the Span to 10 MHz.
Select , set the attenuation to 0 dB, and turn on the preamp.
Select and set the resolution bandwidth to 3 MHz.

Select and set the average trace type.

Select > Marker Function and set the Noise Marker.

o ~ N
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RefLevel -50 dBm S v 10dB A -161.92 dBmHz

Lo

Stop Freq

5.00! Hz

Span
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p Zoom Out

RBW 3 N\ fl / Spa 0 MHz p ~1 ms (1001pts)

SIGLENT )

ontinuous
ctrum Analyzer1 W
pt SA

RefLe dBm Scale/Div 10dB > 000 GHz -161.97

Sweep Time Annotz

Estimated

Continuous

[Start 4.99 z
RBW 3MHz VBW 3 MHz Span 10 MHz

Figure 1-9 Noise power spectral density of unconnected power supply
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SIGLENT W)

Sig Track: ¢ eep: Continuous
Frequency

evel -50 dBm Scale/Div 10dB 5.0 0 GHz ) 05 dBm/MHz Center Freq

Span

Swept

Full Span

Zoom In

S GH
RBW 3MHz VBW 3 MHz

Figure 1-10 Noise power spectral density of connected to power supply

The logarithmic form of noise figure is:

P
NF(dB) = 10IgF = 101g#{‘1t}3 = 10lgP, ¢ — 101gG — 101gB — 101gkT,
0
= Pyu( dBm/Hz) + 174( dBm/Hz) — Gain(dB) = —142 + 174 — 26 = 6

Therefore, the gain measurement method needs to obtain the gain of the DUT and the noise
power spectral density of its output when the physical temperature of the input terminal of the
DUT is 290K. The thermal noise at room temperature is -174 dBm/Hz (the theoretical minimum
value of DANL at room temperature), and the power spectral density can be measured by the
analyzer. The biggest limitation of the measurement comes from the noise floor of the analyzer.
Because the P,,.(dBm/Hz) of a DUT with low gain and low noise figure is very small, which is
often far less than the noise floor of analyzer, the gain measurement method is only suitable for
a DUT with high gain and high noise figure.
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Using the SSA5000A phase noise analysis function

1 Introduction

A stable frequency source is a common need for many electronic devices and most RF equipment.
Phase noise can be used to characterize the short-term frequency stability of these frequency sources.
In this document, we will briefly describe how to use the phase noise analysis function of Siglent
SSA5000A Spectrum analyzers.

2 Typical Phase Noise Measurement Methods

Using the Spectrum analyzers' spectrum analysis mode is the most typical and the most direct
and widely used method to measure phase noise,shown as Figure 2-1.First measure the carrier power
(P¢) in dBm. Next use the delta marker mode to set the marker to a specific frequency offset from the
carrier, i.e. a point in the phase noise sideband. Then we measure the noise power (Pn) in 1 Hz
bandwidth at that offset. If setting the resolution bandwidth (RBW) of the spectrum analyzer to 1Hz
for scanning, it will take too long. You can use the noise marker function to normalize the noise
measured by the RBW filter to 1Hz bandwidth. The power of the noise will be reduced by NdB after
normalization, for which N=10*log(RBW/Hz). In the most cases, measuring phase noise requires
repeating the process at different offsets from the carrier.

E| 34 Input Z: 50 O Atten: 10 dB Sig Track: Off  Avg Type: Power Sweep: Continuous

¥ A Freq Ref: Ext(S) Preamp: Off Avg|Hold: >100/100
A Trig: Free

Spectrum Analyzer1
Swept SA

RefLevel Scale/Div 10 dB > M1A2 10.00 kHz -106.24 dB/Hz
M2

1M’Ww~'w~w»k~ww\)\w

-110 1
tart 999975 MHz Center 1 GHz Stop 1.000025 GHz
RBW 100 Hz VBW 100 Hz Span 50 kHz Sweep(FFT) ~83.421 ms (1001pts),

Figure 2-1 Typical Phase Noise Measurement Methods
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3 Phase noise analysis function

In practical measurements, it is often too cumbersome to repeat the measurement using different
frequency offsets after locating the carrier frequency. The SSA5000A offers an automated
measurement method.

Click Spectrum Analyzer in the upper left corner after powering to enter the window management
page. Click Phase Noise > Log Plot to add a window for phase noise analysis, and then the Spectrum
analyzers will work in the phase noise measurement mode.

The working interface of phase noise analysis is similar to that of spectrum analysis, shown as
follows:

O Mode/Measure : Indicate the current working mode and measurement function of the
analyzer, and click to switch, such as spectrum analysis mode, real-time spectrum mode,
etc.

Instrument Configuration: Indicate the main working states of trace, interface, sweep, trigger,
etc.

Measurement Result: Display the signal measurement results of the analyzer in various
forms such as waveform, spectral line, cursor, table, statistics, and constellation diagram.

Sweep Parameter: Indicate and control the main sweep parameters, such as frequency,
resolution, scanning time, etc.

@ ® ® ©

Menu: Complete the parameter setting of the analyzer.

3 InputZ:50 0 Atten:20dB  Sig Track: Off  Avg Type: Power  Sweep: Single N
viw Freq Ref: Ext(S) Preamp: Off Frequency
A

Phase Noise1
Log Plot

Ref Level -34.8 dBc/Hz Scale/Div 10dB Carrier Power -9.€ > M1 1.0000 MHz -115.72 dBcHz Carrier Frequency

1 GHz

Auto Tune

Start Offset

100 Hz

Stop Offset

1 MHz

-

Start 100 Hz Carrier 1 GHz Stop 1 MHz,

Figure 3-1 Operation interface of phase noise analysis function




5 SIGLENT

3.1 Frequency Settings

Frequency

Carrier Frequency: set the frequency of the carrier

Auto-tune: Spectrum analyzers will automatically Carrier Frequency

locate and set the carrier frequency and set the 1 GHz
offsets.

Start Offset: minimum offset from the carrier

frequency Auto Tune

Stop offset: maximum offset from the carrier
frequency Start Offset

After completing the setup, the Spectrum
analyzers will automate the measurement process and

repeat the measurement within the defined frequency ]
offset range. Stop Offset

1 MHz

100 Hz

Figure 3-2Frequency Settings

3.2 Signal Tracking Setup

Span: Since the input source is not always stable, it will have a frequency deviation around,
resulting in biased test results. This function tracks the frequency deviation within a specified
range, to minimize the effects of frequency deviation.

3.3 Test results reference

The single-sideband phase noise measured within the specified frequency offset range is
shown in Figure 3-3. In the figure, the offset range is 100 Hz to 1 MHz. The log scale is used for
the horizontal axis because in this way it is possible to obtain both a wider frequency range and
a finer resolution when close to the carrier——smaller offsets tend to reflect the quality of the
signal better than phase noise at larger frequency offsets.

. InputZ:50 Q0  Aften:20dB  Sig Track: OFf  Avg Type: Power  Sweep: Single N
Ehaae LorE] v ow Freq Ref: Ext(S) Preamp: Off Frequency
og Plot A

RefLevel -34.8 dBc/Hz Scale/Div 10 dB Carrier Power -9.9 dBm > M1 10000 MHz -11572 dBc/Hz

Auto Tune

Start Offset

100 Hz

Stop Offset

1 MHz

Carrier 1 GHz Stop 1 MHz

Figure 3-3 Test results



U3 SIGLENT

In the Figure 3-3, trace 1 is the original data and trace 2 is the smoothed single-sideband phase
noise.

4 Advantages of SSA5000A phase noise function

4.1 Lower Displayed Average Noise Levels

When using the spectrum analyzer for phase noise measurements, the phase noise is
calculated from the carrier power and the noise power at different offsets of the carrier. The noise
power to be measured is generally small, and in order to keep the phase noise from being
covered by the Spectrum analyzers' display average noise level ( DANL) , the Spectrum
analyzers' display average noise level is required to be very low. The SSA5000A's display
average noise level is lower than -165dBm/Hz. Users can evaluate whether the input signal
amplitude is appropriate and if the measurement is correct based on DANL and the phase noise
of the Spectrum analyzers.

4.2 Smaller resolution bandwidth

The performance of Spectrum analyzers is highly demanded when measuring phase noise
with very small offsets from the carrier. A very narrow resolution bandwidth is required to avoid
measuring carrier power and noise power in an RBW filter. The SSA5000A has a minimum
resolution bandwidth of 1 Hz, and the starting frequency offset in the phase noise measurement
function also supports a 1 Hz setting.

4.3 Lower phase noise

The phase noise of the Spectrum analyzers can also have an effect on the test. Spectrum
analyzers usually have multiple local oscillators (LOs). During testing, the spectrum analyzer's
oscillators have their own phase noise, which will be added to the phase noise of the measured
signal as it moves through different stages in the analyzer.

Therefore, when using a spectrum analyzer to measure phase noise, it is necessary to
distinguish the phase noise in the original signal from the phase noise added by the instrument.
The simplest way is to ensure that the spectrum analyzer's phase noise specifications are far
superior to the device under test (DUT). Siglent's SSA5000A has a phase noise lower than -105
dBc/Hz@1GHz at 10kHz offset, which meets a considerable number of measurement
requirements.
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Using the SSA5000A pulse measurement option

1 Introduction

RF pulse signals are widely used in pules modulated radar, and testing of pulse signals is
necessary for engineers working in related fields. In some critical areas such as aerospace national
defense and radar EW applications, signal design and verification require integrated time
domain/frequency domain/modulation test tools for pulse radar signal analysis. SIGLENT
SSA5000A's Pulse function provides pulse analysis that can help engineers better analyze today’s
dynamic signal environment.

2 Characterization of Pulse Signals
Figure 2-1 shows the simplest way to generate RF pulse signals. The pulse modulator can be
understood as a switch. The baseband pulse controls the on and off of the signal, thereby converting

the input CW signal into a radio frequency pulse signal. This process can also be understood as the
time domain multiplication of CW signal and baseband pulse signal.

Pulse Modulator

Figure 2-1pulse modulated signal

Multiplication of two signals in the time domain is equivalent to the convolution of their spectra.
The spectrum of the CW signal is theoretically a single spectrum line. According to the spectrum of
the baseband pulse signal, the spectrum of the radio frequency pulse signal can be obtained as shown
in Figure 2-2.

,|l|||1.|‘ ‘l.l|||ll, R

f —~pme f

Figure 2-2 spectrum of radio frequency pulse signal
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The pulse-modulated signal is a periodic signal, and its spectrum is a discrete spectrum. The
amplitude of each spectral line changes according to the Sinc function. The spacing between
neighboring spectral lines is the reciprocal of the baseband pulse period T. When actually testing with
a spectrum analyzer, the envelope spectrum or line spectrum can be shown by setting different RBW.
When the RBW is smaller than the spectral line spacing, a line spectrum is obtained; when the RBW
is gradually increased, it is gradually shown as a pulse envelope spectrum.

In terms of the time domain, the greatest characteristic of the pulsed signal is the discontinuity in
time domain. Burst characteristics in the time domain are a basic requirement for pulsed use in radar
applications, and therefore the pulse signal parameters are also the main metrics for radar signal
quality assessment. The time-domain discontinuity of pulsed signals also adds to the difficulties in
power and spectral testing.

In this note we will discuss time and frequency domain testing of pulses.

3 Analysis pulses by using the Pulse Function of the
SSA5000A

3.1 Configure the SSA5000A

As a universal instrument that can handle both spectral power and bandwidth analysis, the
spectrum analyzer can be used for power testing while observing the spectrum if there are no
especially demanding requirements for accuracy. The pulse function of the SSA5000A can be
used to measure pulse width, amplitude and time parameters. In the pulse analysis function, the
spectrum analyzer is in zero-span mode. At this time, the spectrum analyzer is equal to a peak
power meter, which can be used to detect the envelope of the signal at a specific frequency point
with a certain bandwidth and draw the time-dependent power curve. In this case the RBW of the
spectrometer is equivalent to the bandwidth of this detector. The spectrometer in zero span mode
will pin the local oscillator at the center frequency, so we need to set the center frequency
correctly in the frequency settings when performing pulse analysis. Actually, if the center
frequency is offset a little from the actual carrier frequency, you may also get an acceptable test
result, that’s because most of the power of the pulse signal can pass through the IF filter.

SIGLENT 1) Y e B OO B

TrcType: Clear/Write  Input Z: 50 Q Aften: 20dB  Avg Type: Log-Pwr Sweep: Continuous

S| igge
FULEE ¥ Detecor: Normal Freq Ref: Int(S) Preamp: Off Trig: Periodic T

Pulse

Re 0dBm S /Div 10 dB Trigger Source Trigger
Log T
-10

Periodic

Trigger Delay

0s

Trigger Delay
on oft

X Axis Relative
To Trigger

on o

Period

20 ms

Offset Time

VBW 3 MHz o=
Power Measurements

gPower: -2655dBm  PosPeak: 550dBm NegPeak 7243 dBm WaveAvg -59.05 dBm

Peak-Wave: PulseAvg: -5.61dBm

Reset
Offset Display

Pulse Characteristics
Duration Center 5862us Period 4999us  OffTime 19.40 us STESIEE
DutyFac: Freq 20.00 kHz off
Transition Characteristics
Rise-Time 59587 ns LRI-Rise 4305us DIRise 4332us HRIRise
PreQver. 002dB  PreUnder: 1045dB  PostOver. 004dB  PostUnder.
Fall-Time 117us LRIFall 7479us DlFall 7391us HRIFall 73.62 us

Figure 3-1 test result of pulse test
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The test results are shown in Figure 3-1, where the horizontal axis of the spectrometer is time
and the vertical axis is power. The analyzer will automatically recognize the rising and falling edges
of the pulse signal and calculate the power and rise/fall time during pulse switch. For narrow pulses,
you can increase the analyzer's RBW for more accurate measurements. In fact, the rise time
measured by the analyzer generally can’t be better than the optimal rise time of the spectrum analyzer.
The rise time of the analyzer is determined by the following formula: Tr=0.66/max RBW. The maximum
RBW of the SSA5000A is 10MHz, which means that the rise time of the pulse must be greater than
66ns otherwise the analyzer won’t give a correct result. For the line spectrum test, the VBW setting
does not have much effect on the test results of the spectrum, but for the pulse test, the VBW should
not be smaller than the RBW, otherwise it will result in a lower peak power. The VBW filter filters the
envelope of the signal passing through the IF filter. While in pulse test, where multiple spectral lines
pass through the IF filter at the same time, the synthesized envelope has it own bandwidth, and if the
bandwidth is greater than the VBW bandwidth, the test result will be decreased. Generally, when
testing sinusoidal signals, the VBW:RBW is selected from 1 to 3, while testing pulse signals, the
VBW:RBW is generally selected 10 to minimize the effect on signal amplitude.

For pulse signals with known period, you can select periodic trigger in Trigger and set the trigger
Period and pulse period to be the same. Thus, you can get a stabilized triggered pulse signal.

3.2 Result analysis

Pre-Undershoot

Periods

Figure 3-2 Pulse Signal Schematic

The schematic diagram of the pulse is shown in Figure 3-2, from which the individual results of
the pulse measurement can be clearly seen. In the power measurements result Pospeak is the
highest level on the trace and NegPeak is the lowest level on the current trace. The spectrum analyzer
calculates Amptmid = (PosPeak - NegPeak) / 2 + NegPeak. When a trace continuously passes
through the pulse low reference (RefLow, 10%), pulse continuous reference (RefDuration, 50%),
pulse high reference (RefHigh, 90%) (referred to as the rising edge), or when it passes through these
three reference amplitudes in the opposite direction (referred to as the falling edge), mark this trace
as the edge of the pulse. For a complete measurement of the parameters of the pulse, at least 3
edges are required. In pulse characteristics the pulse duration is the time difference between a
positive pulse (negative pulse) passing through the pulse duration reference (RefDuration, 50%) on
the rising edge (falling edge) and a falling edge (rising edge) passing through the pulse duration
reference (RefDuration, 50%).

Pulse Off Time = Pulse Period - Pulse Duration. The duty cycle and frequency of the pulse can
be calculated from the period and pulse width.

In the conversion characteristics, the rise-time is the time spent between the first rising edge of
the pulse crossing RefLow and crossing RefHigh, and the fall time is the time spent between the first
falling edge of the pulse crossing ReHigh and crossing RefLow. And the analyzer will automatically
calculate the Pre-Overshoot, Pre-Undershoot, Post-Undershoot and Post-Overshoot of the pulse in
dB.
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4 Analyze the Spectrum of a Pulse Signal Using SSA5000A

4.1 Measure the pulse spectrum using the swept SA

Measuring the pulse spectrum by sweeping Spectrum Analyzer is the classic way which is
commonly used by engineers in the last decades. This method is suitable for observing stable
pulse signals with known pulse width and period. However, due to the limitation of the sweeping
speed of the swept frequency spectrum analyzer, the analyzer has limit to track and capture the
transient signals, and cannot observe the shortcut pulse signals and broadband modulated pulse
signals well. When observing the Linear Spectrum using a sweep, we need to set the RBW
smaller. However, when the RBW is small, the speed of data acquisition is much faster than the
speed of digital processing speed, so it has a long dead time, and if there are some short
disturbances, it is likely that these signals will be missed. The SSA5000A automatically switches
the scan mode to FFT at 10kHz RBW or lower. In this way the analyzer will stay longer each time
it tunes to a certain frequency, and will also analyze all the energy within a frequency spectrum.
In this sense, the FFT can be viewed as a parallel array of IF filters operating simultaneously,
thus speeding up the sweep speed. Therefore, when analyzing the spectrum of a pulsed signal,
the results obtained using an FFT scan mode will be more accurate. The test results are shown
in Figure 4-1
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Figure 4-1 Spectrum of pulse modulation in SA mode

4.2 Measure the pulse spectrum using the RTSA

Unlike traditional swept spectrum analyzers, real-time spectrum analyzers do not perform
oscillation scanning, but use a broadband ADC to sample signals within a certain bandwidth and
perform spectrum calculations with the help of real-time FFT functions of FPGAs. This enables
continuous spectrum generation of all ADC sample data without loss, so that no instant signal change
is missed. Based on a large number of continuous FFT results, the real-time spectrometer can
perform real-time frequency template triggering as well as three-dimensional displays in the time,
frequency, and amplitude domains to accurately depict the signal change process. The biggest
advantage of real-time spectrum analysis is the uninterrupted measurement of the spectrum and
frequency-selective triggering. So, using these two advantages, RTSA is the most scientific tool for

4



U3 SIGLENT

complex pulse analysis. The test result of spectrum and spectrogram in real-time spectrum mode are
shown in Figure 4-2.

SIGLENT ) L 6 0 @ O OB 3

Disp Trc1: On InputZ:50Q  Atten: 30 dB Trig: Free Sweep: Continue Spectrum+Spectrogram

¥ Disp Trc2: On Freq Ref: Int(S) Preamp: Off Persist Time: 0 s Freq

Real-Time Spec Analyzer1
Spectrum & PvT

Ref 10 dBm M1 5GHz -0.88 dBm 19259s Center Freq

5 GHz
Span

40 MHz

Last Span

Start Freq

4.98 GHz

Stop Freq

19.259 5 5.02 GHz

344 ~ 642

CF Step

40 MHz

CF Step

Auto M

Freq Offset

0 Hz

Display Trc 2
Start 4.98 GHz Center 5 GHz Stop 5.02 GHz
RBW 100.431 kHz Span 40 MHz Acq Time 29.998 ms

Figure 4-2 test result of spectrum and spectrogram
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About SIGLENT

SIGLENT is an international high-tech company, concentrating on R&D, sales,

production and services of electronic test & measurement instruments.

SIGLENT first began developing digital oscilloscopes independently in 2002.
After more than a decade of continuous development, SIGLENT has extended
its product line to include digital oscilloscopes, isolated handheld
oscilloscopes, function/arbitrary waveform generators, RF/MW signal
generators, spectrum analyzers, vector network analyzers, digital multimeters,
DC power supplies, electronic loads and other general purpose test
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firmly believe that today SIGLENT is the best value in electronic test &

measurement.

Follow us on
Facebook: SiglentTech




